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ชุดฝึกทักษะสร้างสรรค์การออกแบบ  เรื่อง เรียนรู้โปรแกรม Adobe Photoshop CS6 

กลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลยี  รายวิชาเทคนิคการตัดต่อภาพ (ง30227)  

ชั้นมัธยมศึกษาปีที่  5  ชุดที่ 1  เรื่อง  แนะน ำกำรใช้โปรแกรม Adobe Photoshop CS6 

มีองค์ประกอบ  ดังนี ้

 

 

   องคป์ระกอบของเนื้อหำ 

 

 

ชุดฝึกทักษะสร้างสรรค์การออกแบบ  เรื่อง  เรียนรู้โปรแกรม Adobe 

Photoshop CS6  ชุดที ่1  เรื่อง แนะน าการใช้โปรแกรม Adobe Photoshop CS6 

มีองค์ประกอบ  ดังนี้ 

ประกอบด้วย 

1.  ค าชี้แจง 

2.  ค าแนะน าส าหรับครู 

3.  ค าแนะน าส าหรับนักเรียน 

4.  สาระ  มาตรฐานการเรียนรู้/ผลการเรียนรู้ 

5.  จุดประสงค์การเรียนรู้ 

6.  แบบทดสอบก่อนเรียนและหลังเรียน พร้อมเฉลย 

7.  ใบความรู้ 

8.  ใบงานที่  1.1 - 1.3  และใบงานที่ 1.4  (ใบงานปฏิบัติ)  พร้อมเฉลย 

9.  บรรณานุกรม 

10.  แบบบันทึกคะแนน 
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  กำรวัดผลประเมินผล 

 

 

การวัดผลประเมินผล ใช้เกณฑ์การประเมินคิดเป็นร้อยละ 80  มีการประเมิน ดังนี้ 

1.  ทดสอบก่อนเรียนและหลังเรียน 

2.  วัดทักษะการปฏิบัติกิจกรรมจากชุดฝึกทักษะ  (ใบงานปฏิบัติ) 

3.  ประเมินทักษะการท างานกลุ่ม 

4.  ประเมินคุณลักษณะอันพึงประสงค์ 

 

 

 

  บทบำทครูผู้สอน 

 

 

1. ครูผู้สอนเตรียมตัวให้พร้อมโดยศึกษารายละเอียดเก่ียวกับการใช้ชุดฝึกทักษะ  

การจัดช้ันเรียนและการเตรียมสื่อการเรียนรู้ที่ใช้ประกอบการจัดการเรียนรู้ 

2. การจัดกิจกรรม ต้องจัดกิจกรรมให้ครบตามที่ระบุไว้ในแผนการจัดการเรียนรู้

เพื่อให้กิจกรรมเป็นไปอย่างต่อเนื่องและบรรลุวัตถุประสงค์ 

3. ก่อนการท ากิจกรรมทุกครั้งต้องอธิบาย ชี้แจงวิธีปฏิบัติกิจกรรมให้ชัดเจน 

เพื่อให้นักเรียนเข้าใจตรงกัน จึงจะท าให้การจัดกิจกรรมการเรียนรู้บรรลุ

เป้าหมายและมีประสิทธิภาพ 

4. ก่อนการท ากิจกรรม ครูจัดกลุ่มนักเรียนออกเป็นกลุ่มละ 7 - 8 คน คละ

ความสามารถประกอบด้วย คนเก่ง ปานกลาง และอ่อน โดยก าหนดบทบาท

หน้าที่การปฏิบัติกิจกรรมการเรียนรู้ของนักเรียนอย่างชัดเจน ซ่ึงให้แต่ละกลุ่ม

เลือก ประธาน รองประธาน กรรมการ และเลขานุการ 
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5. ครูเน้นให้นักเรียนทุกคนมีส่วนร่วมในการปฏิบัติกิจกรรม เพื่อเป็นการ 

ให้นักเรียนรู้จักการท างานร่วมกัน ช่วยเหลือซ่ึงกันและกัน รับผิดชอบต่อหน้าที่

และมีความคิดกล้าแสดงออก โดยครูเป็นผู้แนะน าให้กับนักเรียน ขณะที่

นักเรียนปฏิบัติกิจกรรม 

6. ขณะปฏบิัติกิจกรรม ครูสังเกตพฤติกรรมของนักเรียนแต่ละกลุ่มและบันทึกผล

ในแบบสังเกตพฤติกรรมของนักเรียนเป็นรายกลุ่มหรือรายบุคคล 

7. หลังจากการจัดกิจกรรมการเรียนรู้เสร็จสิ้นครูประเมินผลการเรียนของนักเรียน 

โดยประเมินด้านความรู้ สมรรถนะส าคัญของผู้เรียนและคุณลักษณะอันพึง

ประสงค์ตามเกณฑ์การประเมินและให้นักเรียนประเมินความพึงพอใจต่อการใช้

ชุดฝึกทักษะ 

8. หากเสรจ็สิ้นการจัดกิจกรรมถ้ามีนักเรียนที่ไม่ผ่านเกณฑ์การประเมิน 

ครูจัดกิจกรรมซ่อมเสริมทันทีก่อนเรียนในชุดฝึกทักษะถัดไป 
 

 

 

สิ่งท่ีครูต้องเตรียม 

 

 

1.  แผนการจัดการเรียนรู้ประกอบชุดฝึกทักษะชุดที่  1   

2.  ชุดฝึกทักษะ  ชุดที่ 1  เรื่อง แนะน าการใช้โปรแกรม Adobe Photoshop CS6 

ประกอบด้วย 

2.1  ค าแนะน า 

2.2  แบบทดสอบก่อนเรียนและหลังเรียน 

2.3  ใบความรู้ 

2.4  ใบงาน 

3.  สื่อและอุปกรณ์ที่ใช้ประกอบการปฏิบัติกิจกรรม  (ใบงานปฏิบัติ) 
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ส าหรับครู ควรปฏิบัติกิจกรรม ดังนี้  

1. ชุดฝึกทักษะ  ชุดที่ 1  เรื่อง แนะน าการใชโ้ปรแกรม Adobe Photoshop CS6

ประกอบแผนการจัดการเรียนรู้ที่ 1 - 2  ครูแนะน าแหล่งเรียนรู้เพิ่มเติม 

2. ครูแจ้งมาตรฐานการเรียนรู้  จุดประสงค์การเรียนรู้  ที่นักเรียนศึกษาชุดฝึกทักษะนี้ 

เพื่อให้นักเรียนมีความรู้  เรื่อง โปรแกรม Adobe Photoshop CS6  ครแูนะน า 

ให้นักเรียนศึกษาและการใชชุ้ดฝึกทักษะ เนื้อหาจากใบความรู้และกิจกรรม 

จากใบงานให้เข้าใจก่อน 

3. ครชูี้แจงให้นักเรียน  อ่านค าแนะน าการใช้ชุดฝึกทักษะและปฏิบัติตามขั้นตอน

ตามล าดับ  โดยไม่เปิดดูเฉลยก่อนปฏิบัติกิจกรรมในใบงาน  การท าแบบทดสอบ

ท้ายชุดฝึกทักษะ  โดยเน้นย้ าคุณธรรม  ความซ่ือสัตย์ 

4. ในขณะที่ศึกษาชุดฝึกทักษะนี้  ครูต้องสอนนักเรียนเรื่องความซ่ือสัตย์ต่อตนเอง

และปฏบิัติกิจกรรมโดยไม่เปิดดูเฉลยค าตอบก่อน 

5. หากพบว่า  นักเรียนมีปัญหาระหว่างการเรียนรู้ด้วยชุดฝึกทักษะเล่มนี ้ ครูต้องรีบ 

ให้ความช่วยเหลือจนกว่านักเรียนจะเข้าใจเนื้อหาได้ถูกต้อง  ตรงตามเนื้อหาที่เรียน 
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นักเรียนต้องปฏิบัติกิจกรรม ดงันี ้

 

1. ท าแบบทดสอบก่อนเรียน  เพื่อประเมินความรู้พื้นฐานของตนเองก่อนปฏิบัติ

กิจกรรมในชุดฝึกทักษะ 

2. นักเรียนแบ่งกลุ่ม ให้หัวหน้ากลุ่มเป็นผู้น าในการศึกษาใบความรู้เรื่องนั้น ๆ  

เพือ่ให้เกิดความรู้ความเข้าใจก่อนปฏิบัติตามค าสั่งแต่ละชุดฝึกทักษะ 

3. นักเรียนและครูช่วยกันสรุปสาระส าคัญจากเนื้อหาเพื่อพัฒนาทักษะการเรียน

รายวิชาเทคนิคการตัดต่อภาพ 

4. นักเรียนท าใบงานที่ 1.1 - 1.3  และใบงานที่ 1.4  (ใบงานปฏบิัติ) 

อย่างละเอียดรอบคอบและด้วยความซ่ือสัตย์ต่อตนเอง 

5. นักเรียนท าแบบทดสอบหลังเรียน อย่างละเอียดรอบคอบและด้วยความซ่ือสัตย์

ต่อตนเอง โดยไม่ดูเฉลย 

6. เมื่อมีปัญหาหรือข้อสงสัยเก่ียวกับการท าชุดฝึกทักษะให้ปรึกษาครูผู้สอนทันที 

 

 

 

 

 

 

 

 

 

 

ฝึกบ่อย ๆ ท ำบ่อย ๆ นะคะ 
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ถ้าเพื่อน ๆ ท าใบงานหรือแบบทดสอบหลังเรียน 
ไม่ผ่านเกณฑ์ให้กลับไปศึกษาใบความรู้และท าใบงาน 
อีกครั้งแล้วจึงท าแบบทดสอบอีกรอบนะครับ 

ท ำแบบทดสอบกอ่นเรียน 

- อ่ำนและท ำควำมเข้ำใจกับเนื้อหำในใบควำมรู้ 

- ท ำใบงำนที่ 1.1 – 1.4  ให้ครบ 

- ร่วมตรวจค ำตอบกับเฉลยพร้อม ๆ  กัน  โดยครเูป็นผู้เฉลย 

เมื่อเรียนจบในแต่ละเรื่องเพือ่วัดควำมรู้ที่พฒันำขึ้นในเรื่องนัน้ ๆ 

ชุดที่  1  เรือ่ง  แนะน ำกำรใช้โปรแกรม Adobe Photoshop CS6 

ศึกษำจุดประสงค์กำรเรียนรู ้

 

ท ำแบบทดสอบหลงัเรียน 
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 สำระที่ 3  เทคโนโลยีสำรสนเทศและกำรส่ือสำร 

 มำตรฐำน ง 3.1  เข้าใจ  เห็นคุณค่าและใช้กระบวนการเทคโนโลยีสารสนเทศ 

 ในการสืบค้นข้อมูลการเรียนรู้  การสื่อสาร  การแก้ปัญหา  การท างานและอาชีพ 

 อย่างมีประสิทธิภาพ  ประสิทธิผล  มีคุณธรรม 

 

 ผลกำรเรียนรู ้

 -  สามารถบอกส่วนประกอบหน้าต่างโปรแกรม Adobe Photoshop CS6 ได ้

 -  สามารถบอกคุณสมบัติของเครื่องมือแต่ละกลุ่มได้ 

 -  สามารถปฏบิัติการเก่ียวกับโปรแกรม Adobe Photoshop CS6 ได ้
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  ด้ำนควำมรู้ (K) 

1.  นักเรียนสามารถอธิบายความหมายและประวัติของโปรแกรม Adobe 

Photoshop CS6 ได ้

2.  นักเรียนสามารถบอกความต้องการของโปรแกรม  Adobe Photoshop  

CS6 ได้ 

3.  นักเรียนสามารถบอกวิธีการก าหนดและสร้างไฟล์งานใหม่ได้ 

4.  นักเรียนสามารถอธิบายการเข้าสู่โปรแกรมเพื่อสร้างและก าหนดไฟล์งาน  

ใหม่ในโปรแกรม  Adobe Photoshop CS6 ได้ 

  ด้ำนทักษะ/กระบวนกำร (P) 

1.  นักเรียนสามารถฝึกปฏิบัติกิจกรรมการเข้าสู่โปรแกรมเพื่อสร้างและ 

 ก าหนดไฟล์งานใหม่ในโปรแกรม  Adobe Photoshop CS6 

 ได้อย่างถูกต้อง 

2.  นักเรียนมีทักษะในการท างาน 

3.  นักเรียนมีทักษะในการจัดการงาน 

4.  นักเรียนมีทักษะกระบวนการท างานกลุ่ม 

5.  นักเรียนมีทักษะในการใช้เทคโนโลยี 

  ด้ำนคุณลกัษณะอันพงึประสงค์ (A) 

1.  นักเรียนมีความซ่ือสัตย์สุจริต 

2.  นักเรียนมีวินัย 

3.  นักเรียนมีความตรงต่อเวลา 

4.  นักเรียนมีส่วนร่วมและมีความรับผิดชอบ 

5.  นักเรียนมุ่งมั่นในการท างาน 
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เรื่อง  แนะน ำกำรใช้โปรแกรม Adobe Photoshop CS6 

 

ค ำช้ีแจง ให้นักเรียนท าเครื่องหมายกากบาท ()  ลงในช่องตัวอักษร   

ก  ข  ค  หรือ  ง  ที่ถูกต้องที่สุดเพียงข้อเดียว 

 

1.  ข้อใดต่อไปนี้คือคุณสมบัติของโปรแกรม Adobe Photoshop CS6  

 ก.  แทรกดนตรี    

 ข.  สร้างและตกแต่งภาพ      

 ค.  ถ่ายวีดีโอ    

 ง.  ถ่ายภาพ  

2.  โปรแกรม  Photoshop CS6 เป็นโปรแกรมของบริษัทใด   

 ก.  Acrobat 

 ข.  PostScript 

 ค.  Adobe  

 ง.  PDF 

3.  โปรแกรม  Photoshop  ออกเวอร์ชั่นแรกในปีใด 

 ก.  1987   

 ข.  1988   

 ค.  1989   

 ง.  1990 
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4.  ข้อใดต่อไปนี้ไม่ใช่ส่วนประกอบของโปรแกรม Adobe Photoshop CS6  

 ก.  Menu Bar     

 ข.  Toolbox     

 ค.  Option Bar     

 ง.  Channel 

5.  ข้อใดกล่าวถูกต้องเก่ียวกับ ความสามารถของโปรแกรม Adobe Photoshop CS6 

 ก.  ความสามารถของโปรแกรม Photoshop  แบ่งเป็น 2 เรื่อง คือ แก้ไข 

  ตกแต่งภาพถ่ายกับการรีทชัออกแบบและสร้างสรรค์งานกราฟิก  

 ข.  มีบทบาทในงานธุรกิจและงานการศึกษาสูงมาก 

 ค.  ท าหน้าที่เหมือนกับการท างานใน Explorer 

 ง.  นิยมใช้เพื่องานสื่อสิ่งพิมพ์ 

6.  Panel หมายถึงอะไร 

 ก.  เครื่องมือทุกชิ้นในกล่องเครื่องมือ 

 ข.  วินโดว์เล็ก ๆ ที่ใช้ส าหรับแสดงรายละเอียด หรือควบคุมการท างาน 

 ต่าง ๆ ของโปรแกรม 

 ค.  ปรับค่า Option  ต่าง ๆ ของเครื่องมือที่ก าลังเลือกให้กลับไปเป็น 

 ค่าเริ่มต้น 

 ง.  การปรับแต่งการท างานของเครื่องมือต่าง ๆ 

7.  แถบเมนูหรือ Menu Bar นั้นเป็นแถบส าหรับเลือกค าสั่งท างานซ่ึงจะอยู่ที่ใด 

 ก.  ด้านบน  

 ข.  ด้านล่าง 

 ค.  ด้านซ้าย  

 ง.  ด้านขวา 
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8.  พื้นที่การท างานที่ปรากฏในหน้าจอแรกของโปรแกรม Adobe Photoshop CS6 

เรียกว่าอะไร 

 ก.  Panel 

 ข.  Menu bar 

 ค.  Option bar 

 ง.  Document window 

9.  ค่าพื้นฐานการบันทึกงานบันทึกไฟล์ใน Adobe Photoshop CS6 คืออะไร 

  ก.  Photoshop (*.PSD, *.PDD) 

 ข.  Photoshop PDF (*.PDF, *.PDP) 

 ค.  Photoshop Raw (*.RAW) 

 ง.  Photoshop EPS (*.EPS) 

10.  การท าภาพกราฟิกเพื่อใช้ในงานเว็บ มีหลักการเฉพาะ แตกต่างไปจากงาน 

สื่อสิ่งพิมพ์อ่ืนอย่างไร 

  ก.  เรื่องความละเอียดของภาพ 

 ข.  จ านวนสีที่ใช้แสดงผล 

 ค.  แสง 

 ง.  ถูกทั้งข้อ ก และ ข้อ ข 

 

 

 

 

 

 

 

 

 

 

 

เพื่อน ๆ ท ำข้อสอบ  
ได้ไหมคะ  อย่ำแอบดูเฉลยก่อน

ท ำข้อสอบนะคะ 
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เรื่อง  แนะน ำกำรใช้โปรแกรม Adobe Photoshop CS6 

 

 

ชื่อ - นามสกุล........................................................................เลขที.่............ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

      ลงชื่อ.............................................ผู้ตรวจ 

             (นางสาวพิรุณรัตน์  ศักดิ์แก้ว) 

 

 

 

 

ข้อที ่
ตัวเลือก 

ก ข ค ง 

1     

2     

3     

4     

5     

6     

7     

8     

9     

10     

   1.   เกณฑ์การประเมิน 
1.  ตอบถูกต้อง   ให้ข้อละ  1  คะแนน 
2.  ตอบไม่ถูกต้อง   ให้ข้อละ  0  คะแนน  

  
    2.   แปลผลการประเมิน 
 

 ดี      ได้คะแนน  8 – 10  คะแนน            
 พอใช้  ได้คะแนน  5 – 7    คะแนน 
 ปรับปรุง    ได้คะแนน  0 – 4    คะแนน 

   3.   สรุปผลการประเมิน 
 

   ได้คะแนน  8  คะแนนข้ึนไป  ถือว่า  ผ่าน 
   ได้คะแนนต่ ากว่า  8  คะแนน  ถือว่า  ไม่ผ่าน  
 



 
 

 

13 

 

 

 

 

 

 

 

 

 

 

 Photoshop เป็นโปรแกรมของบริษัท Adobe (อ่านว่า อะ-โด-บี้) ซ่ึงเป็นผู้พัฒนา

ซอฟต์แวร์ด้านกราฟิกและอุตสาหกรรมการพิมพ์รายส าคัญ รวมถึงเป็นผู้คิดค้นภาษา 

Postscript และไฟล์แบบ PDF (Portable Document Format) ที่ใช้กันในวงการพิมพ์และ

การจัดรูปแบบเอกสารบนอินเตอร์เน็ตด้วย ดังนั้น โปรแกรม Photoshop สามารถท างาน

ร่วมและแลกเปลี่ยนไฟล์กับโปรแกรมอ่ืน ๆ ที่ใช้ท างานด้วยกราฟิกได้อย่างกว้างขวาง  

เช่น โปรแกรม illustrator, PageMaker และ Acrobat ซ่ึงทั้งหมดน้ีเป็นของบริษัท Adobe  

เช่นกัน 

 โปรแกรม Photoshop  ออกเวอร์ช่ันแรกในปี 1990 และได้รับการพัฒนาต่อเนื่อง

เรื่อย ๆ เป็นเวอร์ชั่น 2, 2.5, 3, 4, 5, 5.5, 6, 7, CS2, CS3, CS4, CS5, CS6 

จนกระทั่งล่าสุด คือ เวอร์ชั่น CC  ในขณะนี้ โดยมีขีดความสามารถใหม่ ๆ ส าหรับการ

จัดการกับภาพขึ้นมาอีกตัวหนึ่ง คือ Adobe Bridge CS6 ซ่ึงเป็นโปรแกรมที่ใช้ส าหรับ

จัดการภาพถ่ายของเรา ซ่ึงท าหน้าที่เหมือนกับการท างานใน Explorer หรือบางอย่าง

อาจจะท าได้ดีกว่าด้วยซ้ า เช่น การจัดกลุ่มภาพ การแสดงรายละเอียดของภาพ เช่น 

กล้องที่ใช้ถ่ายด้วยเลนส์แบบไหน โฟกัสเท่าไร เป็นต้น และที่ส าคัญคือสามารถดูตัวอย่าง

ไฟล์ภาพของ Photoshop นามสกุล .psd ได้ โดยไม่ต้องเปิดดูในโปรแกรม Photoshop 

และยังมีค าสั่งอัตโนมัติที่สามารถเลือกใช้กับไฟล์ภาพได้อีกด้วย 
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 องค์ประกอบส าคัญในการท า Web ให้ดูน่าสนใจ ต้องมีรูปภาพที่น ามาตกแต่ง  

ซ่ึงผู้พัฒนาหลายๆ คน น าภาพส าเร็จมาใช้งาน น าภาพจากเว็บอ่ืนๆ มาใช้ และก็สร้าง

ภาพเอง โดยอาศัยโปรแกรมกราฟิกต่างๆ เช่น Photoshop, Photo Impact, Paint     

เป็นต้น  โปรแกรม Photoshop เป็นโปรแกรมกราฟิกที่นิยมใช้ในการปรับแต่งภาพ หรือ

สร้างภาพ เพื่อน ามาใช้งานในเว็บ เนื่องจากมีฟังก์ชันการท างาน ที่หลากหลาย มีฟิลเตอร์

เพื่อปรับแต่งภาพ จากค่ายต่างๆ ท าให้ง่ายต่อการปรับแต่งภาพตามต้องการ เดิมทีนิยม

ใช้โปรแกรม Photoshop เพื่องานสื่อสิ่งพิมพ์ (Desktop Publishing) แต่ปัจจุบัน Web 

Design มีบทบาทในงานธุรกิจและงานการศึกษาสูงมาก จึงน า Photoshop มาใช้ในงาน  

นี้ด้วย 

 การท าภาพกราฟิกเพื่อใช้ในงานเว็บ มีหลักการเฉพาะ แตกต่างไปจากงานสื่อ

สิ่งพิมพ์ ทั้งเรื่องความละเอียดของภาพ (Resolution) หรือจ านวนสีที่ใช้แสดงผล เป็นต้น 

ดังนั้นการศึกษาถึง ลักษณะเฉพาะในการใช้ Photoshop สร้างกราฟิกในงานเว็บ จึงเป็น

ศาสตร์ที่น่าสนใจอีกศาสตร์หนึ่ง 
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 ความสามารถของโปรแกรม Photoshop  แบ่งเป็น 2 เรื่อง คือ แก้ไขตกแต่ง

ภาพถ่าย : งานนี้เป็นงานถนัดของ Photoshop เช่น การแก้ไขภาพที่มีให้สว่างการลบ    

ริ้วรอยที่ไม่ต้องการออกจากภาพ รวมถึงการน าภาพหลายๆ ภาพมารวมกัน รวมถึงการ

ตัดต่อ โดยส่วนนี้จะเรียกว่าการรีทัชออกแบบ สร้างสรรค์งานกราฟิก : ใช้ Photoshop 

ช่วยสร้างภาพสามมิติเรื่องของการขีด เขียน ออกแบบสร้างงานกราฟิก เช่น การวาดภาพ

ตัวการ์ตูนหรือการออกแบบสื่อสิ่งพิมพ์ชนิดต่างๆ 

 

 1. งำนออกแบบส่ิงพมิพ ์

  การใช้โปรแกรม Photoshop ช่วยในงานออกแบบสิ่งพิมพ์ทุกชนิด เช่น 

การออกแบบภาพสามมิติ, ออกแบบโลโก้, แบนเนอร์, โบรชัวร์, นามบัตร, ใบปลิว, 

แผ่นพับ, หนังสือ, แค็ตตาล็อกสินค้า, โปสเตอร์, ป้ายโฆษณา, และป้ายหน้าร้าน 

สามารถใช้โปรแกรม Photoshop ในการออกแบบตกแต่ง 

 

 2. งำนออกแบบเวบ็ไซต์ 

  การออกแบบเว็บไซต์ต้องมีภาพกราฟิกที่สวยงามน่าสนใจทั้งการตกแต่ง

ด้วยภาพขนาดต่างๆ การสร้างโลโก้ประกอบเว็บไซต์ การสร้างตัวอักษรซ่ึงการท างาน

เหล่านี้จ าเป็นที่จะต้องใช้โปรแกรม Photoshop ช่วยในการออกแบบ 

 

 3. งำนแก้ไขซ่อมแซมภำพ 

  ภาพต้นฉบับที่เราได้มาในบางครั้งมีข้อบกพร่องหลายๆ อย่าง เช่น ภาพมืด

เกินไปภาพมีรอยขรุขระหรือมี  Noise, ภาพเบลอเกินไป เป็นต้น การที่จะน าภาพที่มี

ข้อบกพร่องมาใช้งาน จ าเป็นต้องท าการแก้ไขและซ่อมแซมภาพก่อนเพื่อให้ภาพมีความ

สมบูรณ์เหมาะสมกับงาน 
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 4. งำนตัดต่อดัดแปลงภำพหรือสร้ำงสรรคง์ำนกรำฟิกสมัยใหม่ 

  งานกราฟิกปัจจุบันผสานเข้ากับการใช้ชีวิตประจ าวัน เช่น ใสข่องปกซีดี 

ปฏิทินตั้งโต๊ะหน้าจอคอมพิวเตอร์ เว็บไซต์ หนังสือปกวารสาร นิตยสาร การ์ด 

ป้ายประชาสัมพันธ์ เครื่องหมายสัญลักษณ์งานเหล่านี้ก็เกิดจากการใช้งานโปรแกรม 

ช่วยในการออกแบบน าภาพมาสร้างสรรค์งานกราฟิกที่สวยงาม มีประโยชน์ใช้สอย 

ตลอดจนมีแนวคิดในการออกแบบที่ดี 

 

 

 

   

 

 โปรแกรม Adobe Photoshop CS6 มีการพัฒนาค าสั่งและเครื่องมือต่าง ๆ ขึ้น

อย่างมากมายจึงเป็นโปรแกรมที่ต้องการทรัพยากรเครื่องค่อนข้างสูง และเพื่อให้การ

สร้างงานกราฟิกมีประสิทธิภาพและเป็นไปด้วยความสะดวก จึงควรท าการตรวจสอบ

เครื่องคอมพิวเตอร์ที่ใช้งานอยู่ ว่ามีทรัพยากรเพียงพอหรือไม่ก่อนที่จะท าการติดต้ัง

โปรแกรม โดยคุณสมบัติของเครื่องคอมพิวเตอร์ที่เหมาะสมในการติดต้ังโปรแกรม 

Adobe Photoshop CS6 มีรายละเอียด  ดังนี ้

 1.1  ระบบปฏิบัติการ Microsoft Windows XP (Service Pack 3)  

หรือระบบปฏบิัติการ  Windows 7 (Service Pack 1) หรือระบบปฏบิัติการ 

Windows 8 

 1.2  หน่วยประมวลผลกลาง (CPU) เป็นของ Intel® Pentium® 4 หรือ 

AMD Athlon® 64 processor ขึ้นไป 

 1.3  หน่วยความจ า (RAM) ขนาด 1 GB ขึ้นไป 

 1.4  พื้นที่จัดเก็บข้อมูล (Hard disk) ขนาด 1 GB ของพื้นที่ว่างบน

ฮาร์ดดิสก์ที่ใช้ได้ส าหรับการติดต้ัง 
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 1.5  จอแสดงผลมีความละเอียดไม่น้อยกว่า 1024 x 768 พิกเซล แสดงผล

แบบ 16 บิตและมีหน่วยความจ าไม่น้อยกว่า 256 MB 

 1.6  ไดร์ฟ DVD-ROM 

 

 

 

  1.  >  ไปที่ ปุ่ม start 

  2.  >  All program 

  3.  >  โฟลเดอร์ Adobe  master  collection CS6 

  4.  >  Adobe  Photoshop CS6 

  5.  >  อีกช่องทางในการเข้าสู่โปรแกรม คือ คลิกเปิดที่ icon Adobe 

Photoshop CS6 ที่หน้าจอ หรือ ไปที่ ปุ่ม start แล้วคลิกที่ icon Adobe Photoshop CS6 

ได้เลย 
 

 
 

 

 

 

http://2.bp.blogspot.com/-YeGELKt7-c8/Ugc0YC3EsoI/AAAAAAAAAWA/LxM6bqgGNfo/s1600/%E0%B9%80%E0%B8%82%E0%B9%89%E0%B8%B2%E0%B9%82%E0%B8%9B%E0%B8%A3%E0%B9%81%E0%B8%81%E0%B8%A3%E0%B8%A1.jpg
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 เมื่อเราเข้าโปรแกรมจะเจอหน้าต่างการท างานของโปรแกรม Adobe Photoshop 

CS6 ซ่ึงจะประกอบไปด้วย  Menu bar Option bar Toolbar Palette ต่างๆ ในการใช้งาน

แต่องค์ประกอบก็จะแตกต่างกันไป 
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 ในกรณีที่เราต้องการสร้างไฟล์งานใหม่ ให้คลิกเมนู  File - > New  และให้ผู้ใช้

ก าหนดขนาดของไฟล์งานใหม่โดยระบุชื่อไฟล์งาน ในช่อง Name ขนาดความสูงความ

กว้างของพื้นที่ท างาน ในส่วน Image Size ตามความต้องการ ก าหนดลักษณะพื้นหลัง 

ในส่วน Contents โดย White (สีขาว), Background Color (สีที่เราก าหนด), 

Transparent (สีพื้นแบบ - โปร่งใส, ไม่แสดงสีพื้นหลงั) 

 1.  กำรเปิดไฟล์ใหม่ขึน้มำท ำงำน 

  1.  Click ที่เมนู File 

  2.  เลือกคาสั่ง New หรือกด Ctrl + N 

  3.  จะปรากฏหน้าต่าง New 

 

 

 

 

 

 

 

 

 

 

  Name  ตั้งชื่อให้กับงาน 

  Preset  ช่องส าหรับเลือกพื้นที่ ที่โปรแกรมก าหนดมาให้ 

  Width  ความกว้าง ซ่ึงมีหน่วยต่าง ๆ เช่น Pixel, เซนติเมตร, นิ้ว 
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  Height    ความสูง ซ่ึงมีหน่วยต่าง ๆ เช่น Pixel, เซนติเมตร, นิ้ว 

  Resolution ค่าความละเอียด (ซ่ึงความละเอียดบนหน้าจอ = 72 px) 

  Color Mode  เลือกชนิดของระบบส ี

 
 

 2.  กำรเปิดไฟล์ภำพ 

  เมื่อเรามีรูปภาพ เช่น ภาพถ่ายซ่ึงต้องการน ามาปรับแต่งเพิ่มเติมเรา

จะต้องท าการเปิดไฟล์รูปภาพนั้นขึ้นมา จากนั้นค่อยก าหนดรูปแบบการปรับแต่งตาม

ความต้องการการเปิดไฟล์รูปภาพท าได้โดยคลิกที่เมนู File->Open จะปรากฏหน้าต่าง 

Open จากนั้นคลิกเลือกชื่อไฟล์รูปภาพที่ต้องการ เมื่อได้ภาพที่ต้องการแล้วให้คลิกที่ปุ่ม 

Open ถ้าต้องการยกเลิกให้คลิกที่ปุ่ม Cancel 

  -  การเปิด File jpeg ต่างๆ 

  การเปิดไฟล์ใหม่ขึ้นมาท างาน 

  1.  Click ที่เมนู File 

  2.  เลือกค าสั่ง Open หรือกด Ctrl + O 

  3.  จะปรากฏหน้าต่างเพื่อหาไฟล์ขึ้น 
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ภำพแสดงกำรค้นหำและเลอืกไฟลท์ี่ต้องกำรเปิด 
 

  4.  จะได้ไฟล์ภาพที่เราต้องการ 
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 3.  กำรย่อ-ขยำยภำพ 

1.  เราต้องการแก้ไขขนาดรูปภาพที่เราได้เปิดขึ้นมาให้ตรงกับความต้องการ 

ให้คลิกที่เมนู Image->Image Size  จะปรากฏหน้าต่าง Image Size จากนั้นให้ก าหนด

ขนาดของรูปภาพเปิดภาพที่เราต้องการจะย่อหรือขยาย ขนาด ด้วยโปรแกรม Adobe 

Photoshop CS6 

 

 

 

 

 

 

 

 

 

 

 

2.  ไปที่เมนู Image => Image Size หรือกดปุ่ม Alt + Ctrl = + Q  
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 3.  จากรูปจะได้ค่า ดังนี ้

 -  Pixel Dimensions จะมีขนาดอยู่ 1.4 OM ที่ขนาดกว้างยาว 564 x 870 pixel 

 -  Document Size จะอยู่ที่ 19.9 x 30.69 cm (เราสามารถปรับเปลี่ยนหน่วย 

เป็นนิ้ว, %, mm หรืออย่างอ่ืนก็ได้) 

 -  Resolution โดยทั่วไปถ้าเป็นรูปที่ใช้ตาม web social ต่างๆ เรามักจะใช้แค่ 

72 dpi (pixelperinch) แต่ถ้าเป็นตามขนาดงานพิมพ์แล้วแค่ตรงนี้ควรจะสูงๆ ไว้ก่อน 

เพื่อความละเอียดของงาน 

 -  ควรจะเลือก Constrain Proportions ไว้ทุกครั้งเพื่อที่จะคงอัตราส่วนกว้าง-ยาว

เอาไว้ คราวนี้ เราจะเพิ่มหรือขนาดรูป ก็สามารถท าได้เลยโดยการปรับแก้ที่ช่องตามที่ได้

อธิบายด้านบน ตามวัตถุประสงค์ของ เราแก้เสร็จก็เซฟงานได้เลย 

 

 

 

 

 

 

 

 

 

 

 

4.  ในการเซฟไฟล์ โปรแกรม Adobe Photoshop CS6 จะถามเราอีกครั้ง 

ในเรื่องของคุณภาพไฟล์ว่าจะเอาขนาดไหน (ตามรูป) ในตัวอย่างจะเลือกแค่ 8 

ก็พอเพียงพอแล้ว โดยค่ายิ่งมากขนาดไฟล์ก็จะใหญ่ขึ้นตาม 
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 การแก้ไขไฟล์ภาพโดยการสร้างกราฟิก เพิ่มการตัดต่อหรือเปลี่ยนแปลงลักษณะ

ของไฟล์ภาพที่มีผลกับโครงสร้างเดิมของภาพเมื่อเลือกค าสั่ง File > Save จะแสดง

ไดอะล็อกบ็อกซ์ Save As ขึ้นมาโดยจะเลือกรูปแบบของไฟล์เป็น Photoshop (*.PSD, 

*.PDD) เป็นค่าพื้นฐานดังนี้ 

 คุณสมบัติของไฟล์ PSD จะเก็บรายละเอียดการท างานต่าง ๆ เช่น เลเยอร์, 

ฟอนต์และเส้นพาธ ไว้ได้อย่างครบถ้วนช่วยให้การน าไฟล์ภาพกลับมาแก้ไขท าได้ง่าย 

ในขณะที่ไฟล์ประเภทอ่ืนจะเก็บข้อมูลเหล่านี้ไม่ไดห้รือได้เพียงบางส่วน 
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 บันทกึไฟล์ทับของเดิม 

 การเปิดไฟล์ภาพมาตกแต่งสี,แสงเงาหรือก าหนดค่าเอฟเฟ็กต์ให้กับภาพแต่ไม่ได้

ใช้ค าสั่งเก่ียวกับการสร้างเลเยอร์ (เลเยอร์คือชั้นที่จัดวางรูปภาพ) หรือสร้างกราฟิกอ่ืนๆ

เพิ่มเติมในภาพเมื่อเลือกค าสั่ง File > Save โปรแกรมจะใหบ้ันทึกทับชื่อไฟล์เดิมรูป

แบบเดิม (จะไม่มีไดอะล็อกบ๊อกซ์ Save As เปิดขึน้มา หากไม่ต้องการให้ทับไฟล์เดิม

ต้องคลิก เลือกค าสั่ง File > Save As) บันทึกเป็นไฟล์รูปแบบอ่ืนๆ 

 นอกจากการบันทึกเป็นไฟล์ .psd และบันทึกลงในรูปแบบของไฟล์ต้นฉบบัเดิม 

แล้วยังบันทึกไฟล์ภาพเก็บไว้ในรูปแบบอ่ืน ๆ ได้ตามต้องการ โดยคลิกเลือกค าสั่ง File > 

Save As แล้วเลือกรูปแบบของไฟล์ในช่อง Format ซ่ึงจะมีรูปแบบไฟล์ให้เลือกหลาย

แบบดังภาพ 
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 กำรเลิกใช้งำนโปรแกรม 

 เมื่อเราต้องการเลิกใช้งานโปรแกรม Adobe Photoshop ด าเนินการ  ดังนี้ 

 -  คลิกเลือกค าสั่ง File --> Exit  หรือคลิกเมาส์ที่เครื่องหมาย 

 -  จากนั้นโปรแกรมจะปิดโดยอัตโนมัติ 
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ชื่อ-นามสกุล ............................................................................เลขที่.............. 
 

ค ำช้ีแจง จงท าเครื่องหมายถูก () หน้าข้อความที่ถูก และท าเครื่องหมาย 

  กากบาท () หน้าข้อความที่ผิดถูกต้อง  (10  คะแนน) 

______ 1.  Photoshop เป็นโปรแกรมส าหรับสร้างและตกแต่งภาพที่มีชื่อเสียง 

และได้รับความนิยมมากที่สุด 

 ______ 2.  องค์ประกอบส าคัญในการท า Web ให้ดูน่าสนใจ คงหนีไม่พ้นรูปภาพ

  ที่น ามาตกแต่ง  

______ 3.  การท าภาพกราฟิกเพื่อใช้ในงานเว็บ มีหลักการเฉพาะ ที่เหมือนกัน 

กับงานสื่อสิ่งพิมพ์ 

______ 4.  ในการเปิดใช้งานโปรแกรม คลิก Start Adobe master collection 

  Adobe Photoshop 

______ 5.  Tool box เป็นกล่องส าหรับเก็บเครื่องมือส าหรับใช้ท างานกับพื้นที่

  ท างานโดยจะประกอบได้ด้วยเครื่องมือหลาย ๆ ชนิดด้วยกัน 

______ 6.  Menu Bar เป็นแถบกลุ่มค าสั่งที่บรรจุค าสั่งส าหรับการท างานทั้งหมด 

  ใน Photoshop CS6 โดยจะแบ่ง ออกเป็น 10 หมวดหมู่ด้วยกันตาม  

  กลุ่มชนิดของการใช้งาน 

______ 7.  Reset All Tools คือปรับค่า option ของเครื่องมือทุกชิ้นในกล่อง

  เครื่องมือกลับไปเป็นค่าเริ่มต้น 

______ 8.  พาเนล หมายถึง วินโดว์เล็กๆ ที่ใช้ส าหรับแสดงรายละเอียด 

  หรือควบคุมการท างานต่างๆ ของโปรแกรม 

 

 

เรื่อง  แนะน ำกำรใช้โปรแกรม Adobe Photoshop CS6 

กลุ่มสำระกำรเรียนรู้กำรงำนอำชีพและเทคโนโลยี ช้ันมัธยมศึกษำปีที่  5 
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______ 9.  พื้นทีก่ารท างานของ Adobe Photoshop CS6 จะเรียกว่า 

Document window 

______ 10.  Edit รวมค าสั่งที่ใช้ส าหรับแก้ไขภาพ และปรับแต่งการท างาน 

  ของโปรแกรมเบื้องต้น 

 

เกณฑ์กำรประเมินใบงำน 

  

 

1.  กำรให้คะแนน 

 

รำยกำร คะแนน 

1. ท าเคร่ืองหมายถูก หน้าข้อความท่ีถูก และท าเคร่ืองหมายกากบาท 

หน้าข้อความท่ีผิดได้ถูกต้อง 
1 

2. ท าเคร่ืองหมายถูก หน้าข้อความท่ีถูก และท าเคร่ืองหมายกากบาท 

หน้าข้อความท่ีผิดไม่ถูกต้อง 
0 

 

2.  สรุปผลกำรประเมิน 

 

         ระดับคุณภาพ   =  3  ดี          (8 – 10     คะแนน) 

         ระดับคุณภาพ    =  2  พอใช้        (5 – 7     คะแนน)   

         ระดับคุณภาพ    =  1  ปรับปรุง    (0 – 4     คะแนน)     

 

 

    ลงชื่อ.....................................................ผู้ตรวจ 

                                             (นางสาวพิรุณรัตน์  ศักดิ์แก้ว)   
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ชื่อ-นามสกุล ............................................................................เลขที่.......... 
 

ค ำช้ีแจง ให้นักเรียนบอกส่วนประกอบหน้าต่างโปรแกรม Adobe Photoshop CS6 

จากภาพที่ก าหนดให้ (6  คะแนน) 

 

 

 

 

 

 

 

 

 

 

 

 

 

1) ……………………………………………………………………………………………………………. 

2) ……………………………………………………………………………………………………………. 

3) ……………………………………………………………………………………………………………. 

 

 

 

เรื่อง   แนะน ำกำรใช้โปรแกรม Adobe Photoshop CS6 

กลุ่มสำระกำรเรียนรู้กำรงำนอำชีพและเทคโนโลยี ช้ันมัธยมศึกษำปีที่  5 

1 2 

3 
4 

5 

6 
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4) ……………………………………………………………………………………………………………. 

5) ……………………………………………………………………………………………………………. 

6) ……………………………………………………………………………………………………………. 

 

เกณฑ์กำรประเมินใบงำน 

  

 

1.  กำรให้คะแนน 

 

รำยกำร คะแนน 

1.  บอกส่วนประกอบหน้าต่างโปรแกรม Photoshop CS6 จากภาพ 

     ท่ีก าหนดให้ได้ถูกต้อง 
1 

2.  บอกส่วนประกอบหน้าต่างโปรแกรม Photoshop CS6 จากภาพ 

     ท่ีก าหนดให้ไม่ถูกต้อง 
0 

 

2.  สรุปผลกำรประเมิน 

 

         ระดับคุณภาพ   =  3  ดี          (5 – 6     คะแนน) 

         ระดับคุณภาพ    =  2  พอใช้        (3 – 4     คะแนน)   

         ระดับคุณภาพ    =  1  ปรับปรุง    (0 – 2     คะแนน)     

 

 

    ลงชื่อ.....................................................ผู้ตรวจ 

                                             (นางสาวพิรุณรัตน์  ศักดิ์แก้ว)   
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ชื่อ-นามสกุล ............................................................................เลขที่.......... 
 

ค ำช้ีแจง ให้นักเรียนตอบค าถามต่อไปนี้ให้ถูกต้อง (10  คะแนน) 

 

1. จงอธิบายความหมายและลักษณะงานที่เก่ียวกับโปรแกรม Adobe Photoshop 

CS6 มาพอเข้าใจ 

……………………………………………………………………………………………………………………………. 

……………………………………………………………………………………………………………………………. 

……………………………………………………………………………………………………………………………. 

……………………………………………………………………………………………………………………………. 

……………………………………………………………………………………………………………………………. 

……………………………………………………………………………………………………………………………. 

 

2. จงอธิบายการเข้าสู่โปรแกรม Adobe Photoshop CS6 มีก่ีขั้นตอนอะไรบ้าง 

……………………………………………………………………………………………………………………………. 

……………………………………………………………………………………………………………………………. 

……………………………………………………………………………………………………………………………. 

……………………………………………………………………………………………………………………………. 

……………………………………………………………………………………………………………………………. 

……………………………………………………………………………………………………………………………. 

……………………………………………………………………………………………………………………………. 

 

 

 

เรื่อง  แนะน ำกำรใช้โปรแกรม Adobe Photoshop CS6 

กลุ่มสำระกำรเรียนรู้กำรงำนอำชีพและเทคโนโลยี ช้ันมัธยมศึกษำปีที่  5 
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3. คุณสมบัติของเครื่องคอมพิวเตอร์ที่เหมาะสมในการติดต้ังโปรแกรม Adobe 

Photoshop CS6 มีคุณสมบัติอย่างไร 

……………………………………………………………………………………………………………………………. 

……………………………………………………………………………………………………………………………. 

……………………………………………………………………………………………………………………………. 

……………………………………………………………………………………………………………………………. 

……………………………………………………………………………………………………………………………. 

……………………………………………………………………………………………………………………………. 

 

4. การสร้างและก าหนดขนาดไฟล์งานใหม่มีอะไรบ้าง 

……………………………………………………………………………………………………………………………. 

……………………………………………………………………………………………………………………………. 

……………………………………………………………………………………………………………………………. 

……………………………………………………………………………………………………………………………. 

……………………………………………………………………………………………………………………………. 

……………………………………………………………………………………………………………………………. 

 

5. จงบอกความสามารถของโปรแกรม Adobe Photoshop CS6  

……………………………………………………………………………………………………………………………. 

……………………………………………………………………………………………………………………………. 

……………………………………………………………………………………………………………………………. 

……………………………………………………………………………………………………………………………. 

……………………………………………………………………………………………………………………………. 

……………………………………………………………………………………………………………………………. 
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เกณฑ์กำรประเมินใบงำน 

  

 

1.  กำรให้คะแนน 

 

รำยกำร คะแนน 

1. เขียนอธิบายถูกต้องตามหัวข้อท่ีก าหนดให้ได้ดีมาก 2 

2. เขียนอธิบายถูกต้องตามหัวข้อท่ีก าหนดให้ได้ แตไ่ม่ชัดเจน 1 

3. เขียนอธิบายถูกต้องตามหัวข้อท่ีก าหนดให้ไม่ถูกต้องหรือไม่ตอบ 0 

 

2.  สรุปผลกำรประเมิน 

 

         ระดับคุณภาพ   =  3  ดี          (8 – 10     คะแนน) 

         ระดับคุณภาพ    =  2  พอใช้        (5 – 7     คะแนน) 

         ระดับคุณภาพ    =  1  ปรับปรุง    (0 – 4     คะแนน) 

 

 

    ลงชื่อ.....................................................ผู้ตรวจ 

                                            (นางสาวพิรุณรัตน ์ ศักดิ์แก้ว)   
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กิจกรรมกลุ่ม : ใบงำนปฏิบัต ิ

ปฏิบัติกิจกรรมวันที่...........เดือน.............................................พ.ศ. .............. 

ค ำช้ีแจง นักเรียนศึกษาเก่ียวกับแนะน าการใช้โปรแกรม Adobe Photoshop CS6 

  ให้เข้าใจและลงมือปฏิบัติกิจกรรมที่ก าหนดให้  

 

  แบบบันทึกแบบฝกึกิจกรรม 

 

ชื่อกลุ่ม...................................................................................... 

สมาชิกกลุ่ม     

1)...........................................................................เลขที่.......... 

2)...........................................................................เลขที่.......... 

3)...........................................................................เลขที่.......... 

4)...........................................................................เลขที่.......... 

5)...........................................................................เลขที่.......... 

6)...........................................................................เลขที่.......... 

7)...........................................................................เลขที่.......... 

8)...........................................................................เลขที่.......... 

 

 

  จุดประสงค์กำรเรียนรู ้

 

นักเรียนสามารถฝึกปฏิบัติกิจกรรมการเข้าสู่โปรแกรมเพื่อสร้างและก าหนด 

ไฟล์งานใหม่โปรแกรม  Adobe Photoshop CS6 ได้อย่างถูกต้อง 

เรื่อง   แนะน ำกำรใช้โปรแกรม Adobe Photoshop CS6 

กลุ่มสำระกำรเรียนรู้กำรงำนอำชีพและเทคโนโลยี  ช้ันมัธยมศึกษำปีที่  5 
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  ส่ือและอุปกรณ์กำรเรียน 

 

 1.  สื่อสิ่งพิมพ์ เช่น หนังสือ ใบความรู้เก่ียวกับแนะน าการใช้โปรแกรม Adobe 

Photoshop CS6  

2.  สื่ออิเล็กทรอนิกส์ เช่น คอมพิวเตอร์ช่วยสอน เว็บไซต์ทางการศึกษาที่ 

น าเสนอเก่ียวกับ Adobe Photoshop CS6 

3.  คอมพิวเตอร์และอุปกรณ์ต่อพ่วงครบชุด 

4.  กระดาษส าหรับเขียนข้อความ 

 

ขั้นตอนกำรปฏิบตัิกิจกรรม 

 

1.  นักเรียนแต่ละกลุ่มศึกษาขั้นตอนแนะน าการใช้โปรแกรม Adobe Photoshop 

CS6 ในใบความรู้และสื่อการเรียนรู้อ่ืน ๆ ที่น ามาประกอบการสอนอย่างละเอียด จากนั้น

ฝึกใช้การใช้งานดังหัวข้อต่อไปนี้ 

 

 -  กำรเข้ำสู่โปรแกรม 

-  กำรสร้ำงและก ำหนดไฟล์งำนใหม ่

 -  กำรบันทึกงำนบันทึกไฟล์ 

  

2.  นักเรียนแต่ละกลุ่มฝึกปฏิบัติกิจกรรมตามขึ้นตอนที่ก าหนดให้ 

  3.  เสร็จกิจกรรมแล้ว นักเรียนแต่ละกลุ่มช่วยกันเก็บวัสดุ อุปกรณ์เครื่องมือเข้าที่

ให้เรียบร้อย 

  4.  นักเรียนแต่ละกลุ่มสรุปผลจากการปฏิบัติกิจกรรมร่วมกัน พร้อมน าเสนอผล

ของกลุ่มให้เพื่อนและครูแสดงความคิดเห็นร่วมกัน 
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แบบบันทึกคะแนนแบบฝึกกิจกรรม 

 

ที่ 
ช่ือ-นำมสกุล 

(สมำชิกกลุ่ม) 

พฤติกรรม 

กำรปฏิบัติงำน 

แ
บ
บ
ฝ
ึก
ก
ิจ
ก
รร
ม

 

รวม ร้อยละ 

 
ค
วำ
ม
ส
น
ใจ

 

ก
ำร
ต
อ
บ
ค
 ำถ
ำม

 

ก
ำร
ต
ั้งใ
จ
ท
 ำง
ำน

 

(4) (4) (4) (20) (32) 

1        

2        

3        

4        

5        

6        

7        

8        

รวม       

 

หมายเหตุ 

……………………………………………………………………………………………………………………..……………………. 

……………………………………………………………………………………………………………………..……………………. 

……………………………………………………………………………………………………………………..……………………. 

……………………………………………………………………………………………………………………..……………………. 
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เกณฑ์กำรประเมินใบงำน 

  

1. กำรให้คะแนน 

 

รำยกำร คะแนน 

1.  ควำมสนใจ 

- มีความกระตือรือร้นใฝ่รู้ ใฝ่เรียน มีความสุขที่ได้เรียน 

- สนุกสนานมีความสุขแต่ขาดความกระตือรือร้น 

- เข้าร่วมกิจกรรม แต่ขาดความกระตือรือร้น 

- เฉื่อยชาแสดงอาการไม่อยากเข้าร่วมกิจกรรม 

4 

3 

2 

1 

2.  กำรตอบค ำถำม 

- ถูกต้องชัดเจนตรงประเด็น 

- ค่อนข้างชัดเจนตรงประเด็น 

- ไม่ค่อยชัดเจน 

- ตอบค าถามไม่ได้ 

4 

3 

2 

1 

3.  กำรตั้งใจท ำงำน 

- ตั้งใจท างานดีเยี่ยม 

- ตั้งใจท างานดี 

- ตั้งใจท างานพอใช้ 
- ไม่ตั้งใจท างาน 

4 

3 

2 

1 

4.  แบบฝึกกิจกรรมที่ 1 

- ท าได้ครบทุกข้อ 5 

- ทันเวลา 5 

- ความสวยงาม 5 

- ความคิดสร้างสรรค์ 5 
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      กำรให้คะแนนแบบฝึกกิจกรรม 

  ปฏิบัติได้ดีมาก    ได้   5   คะแนน   

  ปฏิบัติได้ดี     ได้   4   คะแนน  

  ปฏิบัติได้พอใช้    ได้   3   คะแนน   

  ปฏิบัติได้ค่อยดี    ได้   2   คะแนน 

  ปฏิบัติไม่ได้     ได้   1   คะแนน 

 

 

2.  สรุปผลกำรประเมิน 

 

         ระดับคุณภาพ   =  3  ดี          (26 – 32     คะแนน) 

         ระดับคุณภาพ    =  2  พอใช้        (16 – 25     คะแนน)   

         ระดับคุณภาพ    =  1  ปรับปรุง    (0 – 15     คะแนน)     

 

 

 

    ลงชื่อ.....................................................ผู้ตรวจ 

                                             (นางสาวพิรุณรัตน์  ศักดิ์แก้ว)   
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เรื่อง  แนะน ำกำรใช้โปรแกรม Adobe Photoshop CS6 

 

ค ำช้ีแจง ให้นักเรียนท าเครื่องหมายกากบาท ()  ลงในช่องตัวอักษร   

ก  ข   ค  หรือ  ง  ที่ถูกต้องที่สุดเพียงข้อเดียว 

 

1.  Panel หมายถึงอะไร 

 ก.  เครื่องมือทุกชิ้นในกล่องเครื่องมือ 

 ข.  วินโดว์เล็ก ๆ ที่ใช้ส าหรับแสดงรายละเอียด หรือควบคุมการท างาน 

 ต่าง ๆ ของโปรแกรม 

 ค.  ปรับค่า option  ต่าง ๆ ของเครื่องมือที่ก าลังเลือกให้กลับไป 

 เป็นค่าเริ่มต้น 

 ง.  การปรับแต่งการท างานของเครื่องมือต่าง ๆ 

2.  แถบเมนูหรือ Menu Bar นั้นเป็นแถบส าหรับเลือกค าสั่งท างานซ่ึงจะอยู่ที่ใด 

 ก.  ด้านบน 

 ข.  ด้านล่าง 

 ค.  ด้านซ้าย 

 ง.  ด้านขวา 

3.  พื้นที่การท างานที่ปรากฏในหน้าจอแรกของโปรแกรม Adobe Photoshop CS6 

เรียกว่าอะไร 

 ก.  Panel 

 ข.  Menu bar 

 ค.  Option bar 

 ง.  Document window 

 

 

 



 
 

 

40 

 

4.  ค่าพื้นฐานการบันทึกงานบันทึกไฟล์ใน Adobe Photoshop CS6 คืออะไร 

  ก.  Photoshop (*.PSD, *.PDD) 

 ข.  Photoshop PDF (*.PDF, *.PDP) 

 ค.  Photoshop Raw (*.RAW) 

 ง.  Photoshop EPS (*.EPS) 

5.  การท าภาพกราฟิกเพื่อใช้ในงานเว็บ มีหลักการเฉพาะ แตกต่างไปจากงานสื่อ

สิ่งพิมพอ่ื์นอย่างไร 

  ก.  เรื่องความละเอียดของภาพ 

 ข.  จ านวนสีที่ใช้แสดงผล 

 ค.  แสง 

 ง.  ถูกทั้งข้อ ก และ ข้อ ข 

6.  ข้อใดต่อไปนี้คือคุณสมบัติของโปรแกรม Adobe Photoshop CS6  

 ก.  แทรกดนตรี    

 ข.  สร้างและตกแต่งภาพ      

 ค.  ถ่ายวีดีโอ    

 ง.  ถ่ายภาพ  

7.  โปรแกรม  Photoshop CS6 เป็นโปรแกรมของบริษัทใด   

 ก.  Acrobat 

 ข.  PostScript 

 ค.  Adobe  

 ง.  PDF 

8.  โปรแกรม  Photoshop  ออกเวอร์ชั่นแรกในปีใด 

 ก.  1987   

 ข.  1988   

 ค.  1989   

 ง.  1990 
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9.  ข้อใดต่อไปนี้ไม่ใช่ส่วนประกอบของโปรแกรม Adobe Photoshop CS6  

 ก.  Menu Bar     

 ข.  Toolbox     

 ค.  Option Bar     

 ง.  Channel 

10.  ข้อใดกล่าวถูกต้องเก่ียวกับ ความสามารถของโปรแกรม Adobe Photoshop 

CS6 

 ก.  ความสามารถของโปรแกรม Photoshop  แบ่งเป็น 2 เรื่อง คือ แก้ไข 

  ตกแต่งภาพถ่ายกับการรีทัชออกแบบและสร้างสรรค์งานกราฟิก  

 ข.  มีบทบาทในงานธุรกิจและงานการศึกษาสูงมาก 

 ค.  ท าหน้าที่เหมือนกับการท างานใน Explorer 

 ง.  นิยมใช้เพื่องานสื่อสิ่งพิมพ์ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

เพื่อน ๆ ท ำข้อสอบ  
ได้ไหมคะ  อย่ำแอบดูเฉลยก่อน

ท ำข้อสอบนะคะ 



 
 

 

42 

 

 

 

 

เรื่อง  แนะน ำกำรใช้โปรแกรม Adobe Photoshop CS6 

    

 

ชื่อ - นามสกุล........................................................................เลขที.่............ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

      ลงชื่อ.............................................ผู้ตรวจ 

             (นางสาวพิรุณรัตน์  ศักดิ์แก้ว) 

 

 

 

ข้อที ่
ตัวเลือก 

ก ข ค ง 

1     

2     

3     

4     

5     

6     

7     

8     

9     

10     

   1.   เกณฑ์การประเมิน 
1.  ตอบถูกต้อง   ให้ข้อละ  1  คะแนน 
2.  ตอบไม่ถูกต้อง   ให้ข้อละ  0  คะแนน  

  
    2.   แปลผลการประเมิน 
 

 ดี      ได้คะแนน  8 – 10  คะแนน            
 พอใช้  ได้คะแนน  5 – 7    คะแนน 
 ปรับปรุง    ได้คะแนน  0 – 4    คะแนน 

   3.   สรุปผลการประเมิน 
 

   ได้คะแนน  8  คะแนนข้ึนไป   ถือว่า  ผ่าน 
   ได้คะแนนต่ ากว่า  8  คะแนน  ถือว่า  ไม่ผ่าน  
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เรื่อง  แนะน ำกำรใช้โปรแกรม Adobe Photoshop CS6 

 

 

ก่อนเรียน หลังเรียน 

1.   ข 

2.   ค 

3.   ง 

4.   ง 

5.   ก 

6.   ข 

7.   ก 

8.   ง 

9.   ก 

10.   ง 

 

1.   ข 

2.   ก 

3.   ง 

4.   ก 

5.   ง 

6.   ข 

7.   ค 

8.   ง 

9.   ง 

10.   ก 
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ค ำช้ีแจง จงท าเครื่องหมายถูก () หน้าข้อความที่ถูก และท าเครื่องหมาย 

  กากบาท () หน้าข้อความที่ผิดถูกต้อง   

______ 1.  Photoshop เป็นโปรแกรมส าหรับสร้างและตกแต่งภาพที่มีชื่อเสียง 

และได้รับความนิยมมากที่สุด 

______ 2.  องค์ประกอบส าคัญในการท า Web ให้ดูน่าสนใจ คงหนีไม่พ้นรูปภาพ

  ที่น ามาตกแต่ง  

______ 3.  การท าภาพกราฟิกเพื่อใช้ในงานเว็บ มีหลักการเฉพาะ ที่เหมือนกัน 

กับงานสื่อสิ่งพิมพ์ 

______ 4.  ในการเปิดใช้งานโปรแกรม คลิก Start Adobe master collection 

  Adobe Photoshop 

______ 5.  Tool box เป็นกล่องส าหรับเก็บเครื่องมือส าหรับใช้ท างานกับพื้นที่

  ท างานโดยจะประกอบได้ด้วยเครื่องมือหลาย ๆ ชนิดด้วยกัน 

______ 6.  Menu Bar เป็นแถบกลุ่มค าสั่งที่บรรจุค าสั่งส าหรับการท างานทั้งหมด 

  ใน Photoshop CS6 โดยจะแบ่ง ออกเป็น 10 หมวดหมู่ด้วยกันตาม  

  กลุ่มชนิดของการใช้งาน  

______ 7.  Reset All Tools คือปรับค่า option ของเครื่องมือทุกชิ้นในกล่อง

  เครื่องมือกลับไปเป็นค่าเริ่มต้น 

______ 8.  พาเนล หมายถึง วินโดว์เล็กๆ ที่ใช้ส าหรับแสดงรายละเอียด 

  หรือควบคุมการท างานต่างๆ ของโปรแกรม 

 

 

 

เรื่อง   แนะน ำกำรใช้โปรแกรม Adobe Photoshop CS6 

กลุ่มสำระกำรเรียนรู้กำรงำนอำชีพและเทคโนโลยี ช้ันมัธยมศึกษำปีที่  5 

 

 

 

 

 

 

 

 
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______ 9.  พื้นที่การท างานของ Adobe Photoshop CS6 จะเรียกว่า 

Document window 

______ 10.  Edit รวมค าสั่งที่ใช้ส าหรับแก้ไขภาพ และปรับแต่งการท างาน 

  ของโปรแกรมเบื้องต้น 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
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ค ำช้ีแจง ให้นกัเรียนบอกส่วนประกอบของโปรแกรม Adobe Photoshop CS6 

จากภาพที่ก าหนดให้  

 

 

 

 

 

 

 

 

 

 

 

 

 

1)  แถบค าสั่ง (Menu Bar) 

2)  แถบค าสั่ง (Menu Bar) 

3)  พาเนล (panel) ที่รวบรวมคุณสมบัติการท างานต่าง ๆ อยู่ในกรอบที่ที่จัดเก็บ 

4)  พื้นทีก่ารท างานของ Adobe Photoshop CS6 (Document  window) 

5)  กล่องเครื่องมือ (Toolbox) 

6)  แถบก าหนดรูปแบบของเครื่องมือใช้งาน (Tool options bar) 

 

 

เรื่อง   แนะน ำกำรใช้โปรแกรม Adobe Photoshop CS6 

กลุ่มสำระกำรเรียนรู้กำรงำนอำชีพและเทคโนโลยี ช้ันมัธยมศึกษำปีที่  5 

1 2 

3 
4 

5 

6 
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ค ำช้ีแจง ให้นักเรียนตอบค าถามต่อไปนี้ให้ถูกต้อง  

 

1.  จงอธิบายความหมายและลักษณะงานที่เก่ียวกับโปรแกรม Adobe Photoshop CS6 

มาพอเข้าใจ 

 แนวค ำตอบ Photoshop เป็นโปรแกรมส าหรับสร้างและตกแต่งภาพที่มีชื่อเสียง

และได้รับความนิยมมากที่สุด อันเนื่องมาจากคุณสมบัติเด่นซ่ึงมีอยู่อย่างมากมาย ไม่ว่า

จะเป็นความสามารถจัดการกับไฟล์สารพัดชนิดที่ใช้ในงานประเภทต่าง ๆ ทั้งรูปที่จะ

น าไปผ่านกระบวนการพิมพ์ และรูปที่น าไปใช้ในเว็บเพจหรือส่งผ่านสื่ออิเล็กทรอนิคส์ 

มีความสามารถเป็นเยี่ยมในการแก้ไขตกแต่งภาพ และการสร้างเอฟเฟ็คพิเศษต่าง ๆ 

มีเครื่องมือที่มีประสิทธิภาพและความยืดหยุ่นสูง สามารถบันทึกขั้นตอนที่ต้องท าซ้ า ๆ 

ไว้เรียกใช้ภายหลังตลอดจนมีผู้ผลิตปลั๊กอิน (plug-in) ให้เป็นจ านวนมาก ซ่ึงปลั๊กอิน 

ก็คือโปรแกรมเสริมส าหรับช่วยให้การท างานที่ซับซ้อนส าเร็จลงได้อย่างรวดเร็ว 

2.  จงอธิบายการเข้าสู่โปรแกรม Adobe Photoshop CS6 มีก่ีขั้นตอนอะไรบ้าง 

 แนวค ำตอบ 

 1.  >  ไปที่ ปุ่ม start 

 2.  >  All program 

 3.  >  โฟลเดอร์ Adobe  master  collection cs6 

 4.  >  Adobe Photoshop CS6 

 

 

 

 

เรื่อง   แนะน ำกำรใช้โปรแกรม Adobe Photoshop CS6 

กลุ่มสำระกำรเรียนรู้กำรงำนอำชีพและเทคโนโลยี ช้ันมัธยมศึกษำปีที่  5 
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3.  คุณสมบัติของเครื่องคอมพิวเตอร์ที่เหมาะสมในการติดต้ังโปรแกรม Adobe 

Photoshop CS6 มีคุณสมบัติอย่างไร 

 แนวค ำตอบ 

 • แก้ไขภาพถ่าย  ที่บกพร่องหรือมีต าหนิ เช่น ปรับสีที่เพี้ยน ปรบัแสงเงาที่สว่าง

หรือมืดเกินไปลบแสงแฟลชที่สะท้อนในดวงตา  

         • ตกแต่งภาพ  เช่น ตัดส่วนที่ไม่ต้องการออกไป ลบองค์ประกอบที่รกรุงรัง ปรับ

ภาพให้เบลอหรือคมชัด ปรับผิวกายนางแบบให้ขาวนวลและขจัดไฝฝ้าต่าง ๆ ขจัดเม็ดสี

ที่เกิดในภาพที่สแกนจากสิ่งพิมพ์  

         • ดัดแปลงภาพ เช่น ท าภาพใหม่ให้กลายเป็นภาพสีซีเปียแบบโบราณ หรือแปลง

ภาพเก่า ๆ ที่เป็นขาวด าให้กลายเป็นภาพสี เปลี่ยนภาพคนให้อ้วนขึ้น-ผอมลง หรือเด็ก-

แก่กว่าที่เป็นจริง  

          • ใส่เอฟเฟ็คต์พิเศษ  ให้ภาพ เช่น ท าให้เหมือนก าลังมองภาพผ่านกระจกชนิด

และลายต่าง ๆ หรือเหมือนเงาสะท้อนในน้ า เปลี่ยนภาพถ่ายให้ดูคล้ายภาพวาดด้วย

เครื่องมือหลากหลายชนิด ใส่ประกายแสงหรือเงาให้วัตถุ ท าวัตถุแบน ๆ ให้ดูเป็น 3 มิติ 

เปลี่ยนโทนสีของภาพ  

          • สร้างภาพกราฟิก  ซ่ึงผสมผสานระหว่างภาพถ่าย ข้อความ และภาพวัตถุหรือ

เอฟเฟ็กต์พิเศษที่สร้างขึ้นใน Photoshop เพื่อใช้ในงานผลิตสื่อโฆษณา ท าปกหนังสือหรือ

นิตยสาร หรือใช้ตกแต่งเว็บเพจ  

4.  การสร้างและก าหนดขนาดไฟล์งานใหม่มีอะไรบ้าง 

 แนวค ำตอบ 

 ในกรณีที่เราต้องการสร้างไฟล์งานใหม่ ให้คลิกเมนู   File - > New  และให้ผู้ใช้

ก าหนดขนาดของไฟล์งานใหม่โดยระบุชื่อไฟล์งาน ในช่อง Name ขนาดความสูง 

ความกว้างของพื้นที่ท างาน ในส่วน Image Size ตามความต้องการ ก าหนดลักษณะ 

พื้นหลังในส่วน Contents โดย White (สีขาว), Background Color (สีที่เราก าหนด), 

Transparent (สีพื้นแบบ - โปร่งใส,ไม่แสดงสีพื้นโล่ง) 
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5.  จงบอกความสามารถของโปรแกรม Adobe Photoshop CS6 

แนวค ำตอบ 

1.  งานออกแบบสิ่งพิมพ์  การใช้โปรแกรม Photoshop ช่วยในงานออกแบบสิ่งพิมพ์ 

ทุกชนิด เช่น การออกแบบภาพสามมิติ, ออกแบบโลโก้, แบนเนอร์, โบรชัวร์,  

นามบัตร, ใบปลิว, แผ่นพับ, หนังสือ, แค็ตตาล็อกสินค้า, โปสเตอร์, ป้ายโฆษณา,  

และป้ายหน้าร้าน สามารถใช้โปรแกรม Photoshop ในการออกแบบตกแต่ง 

2.  งานออกแบบเว็บไซต์  การออกแบบเว็บไซต์ต้องมีภาพกราฟิกที่สวยงามน่าสนใจ 

ทั้งการตกแต่งด้วยภาพขนาดต่างๆ การสร้างโลโก้ประกอบเว็บไซต์ การสร้าง 

ตัวอักษรซ่ึงการท างานเหล่านี้จ าเป็นที่จะต้องใช้โปรแกรม Photoshop ช่วยในการ 

ออกแบบ 

3.  งานแก้ไขซ่อมแซมภาพ  ภาพต้นฉบับที่เราได้มาในบางครั้งมีข้อบกพร่องหลายๆ 

อย่าง เช่น ภาพมืดเกินไปภาพมีรอยขรุขระหรือมี  Noise, ภาพเบลอเกินไป เป็นต้น 

การที่จะน าภาพที่มีข้อบกพร่องมาใช้งาน จ าเป็นต้องท าการแก้ไขและซ่อมแซมภาพ

ก่อนเพื่อให้ภาพมีความสมบูรณ์เหมาะสมกับงาน 

4.  งานตัดต่อดัดแปลงภาพหรือสร้างสรรค์งานกราฟิกสมัยใหม่  งานกราฟิกปัจจุบัน 

ผสานเข้ากับการใช้ชีวิตประจ าวัน เช่น ใส่ของปกซีดี ปฏิทินตั้งโต๊ะหน้าจอคอมพิวเตอร์  

เว็บไซต์ หนังสือปกวารสาร นิตยสาร การ์ด ป้ายประชาสัมพันธ์ เครื่องหมายสัญลักษณ์ 

งานเหล่านี้ก็เกิดจากการใช้งานโปรแกรมช่วยในการออกแบบน าภาพมาสร้างสรรค์ 

งานกราฟิกที่สวยงาม มีประโยชน์ใช้สอย ตลอดจนมีแนวคิดในการออกแบบที่ดี 

 


